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Êîëëàæîì íàçûâàåòñÿ ãðàôè÷åñêàÿ ðàáîòà, ñîçäàííàÿ ñ 
ïðèìåíåíèåì íàáîðà ðàçëè÷íûõ èçîáðàæåíèé — ôîòîãðàôèé 
èëè ðèñóíêîâ. Ó÷èòûâàÿ îãðîìíóþ ïîïóëÿðíîñòü ïðîãðàììû 
Photoshop è åãî èäåîëîãèþ ñëîåâ, êîòîðûå ïðåäñòàâëÿþò ñîáîé 
íàêëàäûâàåìûå äðóã íà äðóãà îòäåëüíûå èçîáðàæåíèÿ, ìîæíî 
ñ÷èòàòü, ÷òî áîëüøèíñòâî ñîâðåìåííûõ èçîáðàæåíèé ÿâëÿþòñÿ 
êîëëàæîì. 

Â äàííîé êíèãå ðàññìîòðåíî ñîçäàíèå äâóõ êîëëàæåé, 
êîòîðûå ðàçëè÷àþòñÿ ïî ñâîåìó âèäó è ïðèìåíÿåìûì 
òåõíèêàì. Âíà÷àëå äàþòñÿ èñõîäíûå èçîáðàæåíèÿ è êîíå÷íûé 
ðåçóëüòàò, à çàòåì ïî øàãàì ïîêàçûâàåòñÿ, êàê åãî ïîëó÷èòü. 

Ñîãëàøåíèÿ
Ïðè ñîçäàíèè êîëëàæåé èñïîëüçóþòñÿ èíñòðóìåíòû Photoshop, 
êîòîðûå çàëîæåíû â íåãî åùå â îòíîñèòåëüíî ñòàðûõ âåðñèÿõ 
ïðîãðàììû. Ïîýòîìó íå èìååò çíà÷åíèÿ, êàêàÿ âåðñèÿ 
óñòàíîâëåíà ó âàñ íà êîìïüþòåðå — 6.0 èëè 8.0 (CS). Ïðèåìû 
îäèíàêîâî áóäóò ðàáîòàòü è â òîì è äðóãîì ñëó÷àå. 

Îáîçíà÷åíèÿ èíñòðóìåíòîâ è ïóíêòîâ ìåíþ äàþòñÿ äëÿ 
àíãëèéñêîé âåðñèè, â ñêîáêàõ ïðèâîäèòñÿ ïåðåâîä, íî îí 
ìîæåò è îòëè÷àòüñÿ îò ðóññêîÿçû÷íîé âåðñèè, êîòîðîé âû 
ïîëüçóåòåñü. 

Êëàâèàòóðíûå ñîêðàùåíèÿ (ãîðÿ÷èå êëàâèøè) äëÿ áûñòðîãî 
âûçîâà êîìàíä ïîìå÷àþòñÿ óãëîâûìè ñêîáêàìè (íàïðèìåð, 
<Q>). Ïðè ýòîì âñåãäà èñïîëüçóþòñÿ áóêâû ëàòèíñêîãî 
àëôàâèòà, ïîýòîìó ïîä <A> ïîäðàçóìåâàåòñÿ àíãëèéñêàÿ, à 
íå ðóññêàÿ áóêâà. Ó÷òèòå, ÷òî Photoshop íå «ëþáèò», êîãäà 
âêëþ÷åíà ðóññêàÿ ðàñêëàäêà êëàâèàòóðû, â ýòîì ñëó÷àå ãîðÿ÷èå 
êëàâèøè íå ðàáîòàþò. Ïåðåêëþ÷èòåñü íà àíãëèéñêèé ÿçûê è 
ïîïðîáóéòå ñíîâà.  

Ïîääåðæêà
Âàøè çàìå÷àíèÿ, ïðåäëîæåíèÿ è âîïðîñû íàïðàâëÿéòå àâòîðó 
íà àäðåñ ýëåêòðîííîé ïî÷òû vlad@htmlbook.ru

Ìíîæåñòâî ìàòåðèàëîâ è ïðèìåðîâ, ñâÿçàííûõ ñ òåìîé 
êíèãè ìîæíî ïîñìîòðåòü â Èíòåðíåòå íà ñàéòå àâòîðà ïî 
àäðåñó http://www.htmlbook.ru
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Èñõîäíûå èçîáðàæåíèÿ ìîæíî áðàòü ñ ðàçíûõ ìåñò, 
íàïðèìåð, èç áèáëèîòåê ôîòîèçîáðàæåíèé, ñêàíèðîâàíèåì 
ïëåíîê è ôîòîãðàôèé, ñúåìêîé íà öèôðîâîé ôîòîàïïàðàò 
è ò.ä. Åñòåñòâåííî, ñëåäóåò ïîìíèòü îá àâòîðñêîì ïðàâå, 
êîòîðîå ðàñïðîñòðàíÿåòñÿ íà ôîòîãðàôèè, òàê ÷òî ïåðåä 
èõ èñïîëüçîâàíèåì ëó÷øå çàðàíåå ïîáåñïîêîèòüñÿ îá ýòîì 
âîïðîñå. 

×òîáû ôîòîãðàôèè õîðîøî ñî÷åòàëèñü äðóã ñ äðóãîì, íàäî 
ïðèíèìàòü âî âíèìàíèå íåêîòîðûå îñîáåííîñòè, êîòîðûå 
ïåðå÷èñëåíû äàëåå.

Îñâåùåíèå îáúåêòîâ
Âåñüìà íåëåïî ñìîòðÿòñÿ êîëëàæè, â êîòîðûõ îáúåêòû 
îñâåùàþòñÿ ñ ðàçíûõ ñòîðîí. Ãäå ðàñïîëîæåí èñòî÷íèê 
ñâåòà, ìîæíî ïîíÿòü ïî áëèêàì, áîëåå ñâåòëûì ïÿòíàì èëè 
ïî òåíè. Ïîýòîìó íàäî ñðàçó ïîçàáîòèòüñÿ î òîì, ÷òîáû òåíè 
íà ðàçíûõ ôîòîãðàôèÿõ ïàäàëè â îäíó ñòîðîíó. Òàêæå ìîæíî 
âîñïîëüçîâàòüñÿ áåñòåíåâûìè ôîòîãðàôèÿìè, êîòîðûå ìîæíî 
ïîëó÷èòü â ïàñìóðíóþ ïîãîäó èëè ñïåöèàëüíûì îñâåùåíèåì â 
ñòóäèéíûõ óñëîâèÿõ.

Çåðíèñòîñòü
Åñëè èçîáðàæåíèå ñêàíèðóåòñÿ ñ ïëåíêè èëè ôîòîãðàôèè, 
òî â íèõ îáÿçàòåëüíî ïðèñóòñòâóåò çåðíèñòîñòü, êîòîðàÿ òåì 
âûøå, ÷åì âûøå ÷óâñòâèòåëüíîñòü ïëåíêè. Ïðè ñî÷åòàíèè 
òàêèõ ôîòîãðàôèé ñ öèôðîâûìè èçîáðàæåíèÿìè, ìåæäó íèìè 
âîçíèêàåò äèññîíàíñ. ×òîáû ýòîãî íå ïðîèçîøëî, ôîòîãðàôèè 
äîëæíû áûòü îäíîòèïíû èëè èõ òàêîâûìè íåîáõîäèìî ñäåëàòü 
ñ ïîìîùüþ ñïåöèàëüíûõ ôèëüòðîâ èìèòèðóþùèõ çåðíèñòîñòü 
ôîòîãðàôèè.

Õîòÿ ó ôîòîãðàôèé, ïîëó÷åííûõ ñ ïîìîùüþ öèôðîâîé 
êàìåðû, çåðíèñòîñòè êàê òàêîâîé è íåò, íî ó íèõ åñòü äðóãàÿ 
îñîáåííîñòü — øóì. Îí ïðîÿâëÿåòñÿ â ñíèæåíèè êà÷åñòâà 
èçîáðàæåíèÿ è ïîÿâëåíèè ïàðàçèòíûõ îòòåíêîâ öâåòîâ. Êàê 
ïðàâèëî, çàìåòíûé øóì âîçíèêàåò ïðè íèçêîì îñâåùåíèè è 
óñòàíîâëåííîé âûñîêîé ÷óâñòâèòåëüíîñòè.

Öâåò
Îòòåíêè öâåòîâ îäíèõ è òåõ æå îáúåêòîâ íà ðàçëè÷íûõ 
ôîòîãðàôèÿõ íå äîëæíû ñèëüíî ðàçëè÷àòüñÿ ìåæäó ñîáîé, 
èíà÷å öåëüíîãî èçîáðàæåíèÿ íå ïîëó÷èòñÿ. Òàê ÷òî 
ïåðåä èñïîëüçîâàíèåì ôîòîãðàôèé òðåáóåòñÿ ïðîâåñòè èõ 
öâåòîêîððåêöèþ, â ÷àñòíîñòè, óñòàíîâèòü áàëàíñ áåëîãî. 
Áàëàíñ áåëîãî — ýòî ïðîöåññ, ïðè êîòîðîì îïðåäåëåííàÿ 
òî÷êà ôîòîãðàôèè óêàçûâàåòñÿ êàê áåëàÿ. Äåëî â òîì, ÷òî 
ïî ñðàâíåíèþ ñ ÷åëîâå÷åñêèì ãëàçîì ëþáîé öèôðîâîé 
ôîòîàïïàðàò íåñîâåðøåíåí, ïîýòîìó îí ìîæåò îêðàøèâàòü 
öâåò, êîòîðûé ãëàçîì îäíîçíà÷íî âîñïðèíèìàåòñÿ êàê áåëûé, 
â ÷óæåðîäíûå îòòåíêè. Îòìåòèì, ÷òî ñîâðåìåííûå àïïàðàòû 

Ïîäãîòîâêà 
èçîáðàæåíèé
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óæå äîñòàòî÷íî êîððåêòíî óìåþò ðàáîòàòü ñ öâåòîì, êðîìå 
òîãî, îíè ïîääåðæèâàþò óñòàíîâêó áàëàíñà áåëîãî ïî ëèñòó 
áóìàãè. 

Ðàçìåð èçîáðàæåíèé
Öåëü ñîçäàíèÿ êîëëàæà ìîæåò áûòü ðàçíîé — îò 
èñïîëüçîâàíèÿ íà ñàéòå äî ïå÷àòè åãî íà ïðèíòåðå. 
Êîíå÷íûé ðàçìåð èçîáðàæåíèÿ â òàêîì ñëó÷àå ìîæåò ñèëüíî 
ðàçëè÷àòüñÿ. Òåì íå ìåíåå, â ëþáîì ñëó÷àå óäîáíåå ðàáîòàòü 
ñ èçîáðàæåíèÿìè, äîñòàòî÷íî áîëüøèìè ïî øèðèíå è âûñîòå. 
Â òàêîì ñëó÷àå ïîâûøàåòñÿ òî÷íîñòü ðåçóëüòàòà è óäîáñòâî 
ìàíèïóëèðîâàíèÿ ñ îáúåêòàìè. Ïîíÿòèå «áîëüøîé», êîíå÷íî 
æå, óñëîâíî, ðàçíèöà ìåæäó ïîëèãðàôè÷åñêèì èçîáðàæåíèåì 
è ôîòîãðàôèåé íà âåá-ñòðàíèöå ìîæåò ñîñòàâëÿòü íåñêîëüêî 
ïîðÿäêîâ. 

Òàêèì îáðàçîì, ïîëó÷àåòñÿ, ÷òî ëó÷øå âñåãî ãîòîâèòü 
èçîáðàæåíèÿ äëÿ êîëëàæà ñàìîñòîÿòåëüíî, ïîëüçóÿñü 
öèôðîâûì ôîòîàïïàðàòîì. Ïîïóëÿðíîñòü ýòîé òåõíèêè è 
øèðîêèé öåíîâîé äèàïàçîí ïîçâîëÿåò âûáðàòü ôîòîàïïàðàò ïî 
ñâîèì ñðåäñòâàì è öåëÿì. Ýòî â ñâîþ î÷åðåäü äåëàåò ñîçäàíèå 
êà÷åñòâåííûõ êîëëàæåé âïîëíå äîñòóïíûì äåëîì ïðàêòè÷åñêè 
äëÿ êàæäîãî ÷åëîâåêà. 
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Êîëëàæ 1
Äåâî÷êà íà ãðèáå

Ìîäåëü Óëüÿíà Êóçíåöîâà
Ôîòî Àíàñòàñèÿ Ñòàðîâàòîâà è Óëüÿíà Êóçíåöîâà
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Íàøà çàäà÷à — ïîñàäèòü äåâî÷êó íà ãðèá ïðè ñîõðàíåíèè 
ðåàëèñòè÷íîñòè èçîáðàæåíèÿ. Îáà èñõîäíûõ èçîáðàæåíèÿ 
áûëè ñäåëàíû öèôðîâûì ôîòîàïïàðàòîì, ïðè ýòîì êîíå÷íûé 
âèä êîëëàæà áûë ïðîäóìàí çàðàíåå. Òàê ÷òî îñòàâàëîñü òîëüêî 
îòûñêàòü ïîäõîäÿùèå îáúåêòû ñúåìêè. Ãðèá íàøåëñÿ ñðàçó, çà 
äîìîì â òðàâå (ðèñ. 1.1), à äåâî÷êó ïîñàäèëè íà ïîäîêîííèê è 
â òàêîì âèäå ñôîòîãðàôèðîâàëè (ðèñ. 1.2).

Ðèñ. 1.1. Èñõîäíîå èçîáðàæåíèå 
ãðèáà

Ðèñ. 1.2. Èñõîäíîå 
èçîáðàæåíèå äåâî÷êè

Èñïîëüçîâàíèå 
áûñòðîé ìàñêè

Ïðè ñîçäàíèè êîëëàæà îáÿçàòåëüíî ïðèõîäèòñÿ î÷èùàòü 
îáúåêò îò ôîíà äëÿ åãî äàëüíåéøåãî íàëîæåíèÿ íà äðóãîé 
ôîí. Òàê ÷òî ïðèäåòñÿ èñïîëüçîâàòü âûäåëåíèå. Â ïðîãðàììå 
Photoshop äëÿ ýòîé öåëè ñóùåñòâóåò ìíîæåñòâî ñðåäñòâ, íî â 
äàííîì ñëó÷àå íå âñå îíè ãîäÿòñÿ, ïîñêîëüêó íå îáåñïå÷èâàþò 
íóæíóþ òî÷íîñòü èëè óäîáñòâî ðàáîòû. Äàëåå ðàññìîòðåíî äâà 
ñïîñîáà, â ÷àñòíîñòè, èñïîëüçîâàíèå áûñòðîé ìàñêè è ñëîé-
ìàñêè. Îáà ìåòîäà ïîçâîëÿþò äîáèòüñÿ íóæíîãî ðåçóëüòàòà 
áûñòðî è ýôôåêòèâíî. 

Áûñòðàÿ ìàñêà ïîçâîëÿåò ðåäàêòèðîâàòü âûäåëåíèå â ðåæèìå 
ïðîñìîòðà äîêóìåíòà. ×òîáû òî÷íî âûäåëèòü íóæíûé îáúåêò, 
òðåáóåòñÿ ïðîéòè íåñêîëüêî øàãîâ.
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Øàã 1. Âûäåëåíèå îáúåêòà
Âûäåëÿåì äåâî÷êó íà ôîòîãðàôèè ñ ïîìîùüþ èíñòðóìåíòà 
Lasso (Ëàññî, âûçîâ ÷åðåç ãîðÿ÷óþ êëàâèøó <L>). Òî÷íîñòü â 
äàííîì ñëó÷àå îñîáîãî çíà÷åíèÿ íå èìååò, ãëàâíîå ïîëó÷èòü 
âûäåëåííóþ îáëàñòü (ðèñ. 1.3).

Ðèñ. 1.3. Âûäåëåííàÿ îáëàñòü â ôîòîãðàôèè

Øàã 2. Ïåðåêëþ÷åíèå â ðåæèì áûñòðîé ìàñêè
Ïåðåõîäèì â ðåæèì áûñòðîé ìàñêè. Äëÿ ýòîãî íà ïàíåëè 
èíñòðóìåíòîâ íàæèìàåì êíîïêó, êîòîðàÿ ïîêàçàíà íà ðèñ. 1.4. 
Àíàëîãè÷íûé ðåçóëüòàò ìîæíî ïîëó÷èòü, åñëè íàæàòü íà 
êëàâèøó <Q>. Çàìåòèì, ÷òî ðåçóëüòàò áóäåò çàìåòåí òîëüêî 
â òîì ñëó÷àå, åñëè èìååòñÿ âûäåëåííàÿ îáëàñòü, âîò äëÿ ÷åãî 
òðåáóåòñÿ âíà÷àëå åå ñîçäàòü. Åñëè âûäåëåíèÿ íåò, òî íèêàêîãî 
âèäèìîãî ýôôåêòà íàæàòèå íà êíîïêó Quick Mask (Áûñòðàÿ 
ìàñêà) íå äàñò.

Ðèñ. 1.4. Êíîïêà äëÿ ïåðåêëþ÷åíèÿ â ðåæèì Quick Mask

 — èíñòðóìåíò Lasso.

Èñïîëüçîâàíèå èíñòðóìåíòà 
Lasso îäíîâðåìåííî ñ 
íàæàòîé êëàâèøåé <Shift> 
ïîçâîëÿåò äîáàâëÿòü 
îáëàñòü ê ñóùåñòâóþùåìó 
âûäåëåíèþ. Óäåðæèâàíèå 
êëàâèøè <Alt> âî âðåìÿ 
ïðèìåíåíèÿ èíñòðóìåíòà 
Lasso ïîçâîëÿåò âû÷èòàòü èç 
ñóùåñòâóþùåãî âûäåëåíèÿ 
îáîçíà÷åííóþ îáëàñòü. 
Àíàëîãè÷íûé ðåçóëüòàò äàåò 
èñïîëüçîâàíèå êíîïîê â 
ïàíåëè ñâîéñòâ èíñòðóìåíòà 
Lasso, êàê ïîêàçàíî íèæå. 
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Ïîñëå ïåðåêëþ÷åíèÿ â ðåæèì Quick Mask âûäåëåííàÿ 
îáëàñòü çàêðàøèâàåòñÿ ïîëóïðîçðà÷íûì îäíîòîííûì öâåòîì 
(ðèñ. 1.5). 

Ðèñ. 1.5. Âûäåëåííàÿ îáëàñòü â ðåæèìå Quick Mask

Ïàðàìåòðû Áûñòðîé ìàñêè, òàêèå êàê: öâåò îáëàñòè, 
âåëè÷èíà ïðîçðà÷íîñòè, ïîìå÷àòü âûäåëåííóþ èëè 
ìàñêèðîâàííóþ îáëàñòü ìîæíî óñòàíîâèòü, äâàæäû ùåëêíóâ ïî 
êíîïêå Áûñòðîé ìàñêè (ðèñ. 1.4). Â ýòîì ñëó÷àå îòêðûâàåòñÿ 
ïàíåëü äëÿ èçìåíåíèÿ îïöèé Quick Mask (ðèñ. 1.5). 

Ðèñ. 1.6. Ïàðàìåòðû Quick Mask
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Øàã 3. Ðåäàêòèðîâàíèå ìàñêè
Ïåðåêëþ÷àåìñÿ íà èíñòðóìåíò Brush (Êèñòî÷êà, âûçîâ ÷åðåç 

ãîðÿ÷óþ êëàâèøó <B>). 
Ëþáàÿ ìàñêà ïðåäñòàâëÿåò ñîáîé ÷åðíî-áåëîå èçîáðàæåíèå, 

ïîýòîìó â äàííîì ñëó÷àå äëÿ åå ðåäàêòèðîâàíèÿ íàì 
ïîòðåáóþòñÿ òîëüêî áåëûé è ÷åðíûé öâåòà. Íàæìèòå êëàâèøó 
<D>, è íà ïàíåëè èíñòðóìåíòîâ öâåò ïåðåäíåãî ïëàíà ñòàíåò 
÷åðíûì, à ôîíà — áåëûì (ðèñ. 1.7).

Ðèñ. 1.7. Öâåòà äëÿ ðåäàêòèðîâàíèÿ ìàñêè

Òåïåðü êèñòüþ àêêóðàòíî çàêðàøèâàåì ôèãóðó äåâî÷êè 
(ðèñ. 1.8). ×òîáû äîáèòüñÿ áîëåå òî÷íîãî ðåçóëüòàòà 
ïðèìåíÿéòå ìàñøòàáèðîâàíèå è êèñòè ðàçíîãî ðàçìåðà. 
Èñïîëüçîâàíèå êèñòåé ñ ìÿãêèìè êðàÿìè ïîçâîëÿåò ïîëó÷èòü 
ïîëóïðîçðà÷íóþ ìàñêó. 

Ðèñ. 1.8. Èñïîëüçîâàíèå êèñòåé äëÿ ñîçäàíèÿ âûäåëåíèÿ

Â äàííîì ñëó÷àå îøèáîê ìîæíî íå îïàñàòüñÿ, ïîñêîëüêó 
ïåðåêëþ÷åíèå ñ ÷åðíîãî íà áåëûé öâåò è îáðàòíî (ãîðÿ÷àÿ 
êëàâèøà <X>), ïîçâîëÿåò òî÷íî ðåäàêòèðîâàòü îáëàñòü 
âûäåëåíèÿ. 

 — èíñòðóìåíò 
Brush.

Ïðè ðåäàêòèðîâàíèè 
áûñòðîé ìàñêè 
æåëàòåëüíî â 
íàñòðîéêàõ ïðîãðàììû 
óñòàíîâèòü, ÷òîáû êèñòü 
îòîáðàæàëàñü ñîãëàñíî 
åå ðàçìåðó. Äëÿ ýòîãî 
çàéäèòå â ïóíêò ìåíþ 
Edit > Preferences > 
Display & Cursors... 
(Ðåäàêòèðîâàíèå > 
Íàñòðîéêè > 
Îòîáðàæåíèå è 
êóðñîðû) è âûáåðèòå 
ïóíêò Brush Size 
(êóðñîð ïî ðàçìåðó 
êèñòè), êàê ïîêàçàíî íà 
ðèñóíêå íèæå.
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Øàã 4. Âîçâðàùåíèå â îáû÷íûé ðåæèì ðåäàêòèðîâàíèÿ
Ïîñëå çàêðàøèâàíèÿ íåîáõîäèìîé îáëàñòè (ðèñ. 1.9) 
âîçâðàùàåìñÿ â îáû÷íûé ðåæèì ðåäàêòèðîâàíèÿ (ñíîâà 
íàæèìàåì êëàâèøó <Q>). Òåïåðü äåâî÷êà íà ôîòîãðàôèè 
ïîëíîñòüþ âûäåëåíà, è íóæíî ëèøü óäàëèòü ôîí âîêðóã íåå 
(ðèñ. 1.10). 

 
Ðèñ. 1.9. Âûäåëåíèå â ðåæèìå 

Quick Mask
Ðèñ. 1.10. Âûäåëåíèå â îáû÷íîì 

ðåæèìå

Øàã 5. Èíâåðòèðîâàíèå âûäåëåíèÿ
Ïîñêîëüêó òðåáóåòñÿ óäàëèòü ôîí, òî âûäåëåíèå íåîáõîäèìî 
èíâåðòèðîâàòü (Select > Inverse, Âûäåëåíèå > Èíâåðòèðîâàòü). 
Òàêæå ìîæíî âîñïîëüçîâàòüñÿ ñî÷åòàíèåì êëàâèø 
<Shift>+<Ctrl>+<I>. Íî ïðåæäå ÷åì óäàëÿòü, òðåáóåòñÿ 
ïðîèçâåñòè ïðîñòóþ ìàíèïóëÿöèþ ñî ñëîåì. Äåëî â òîì, ÷òî 
íàì òðåáóåòñÿ ïðîçðà÷íûé ôîí, à äëÿ ñëîÿ Background (Ôîí), 
êîòîðûé ïî óìîë÷àíèþ óñòàíîâëåí äëÿ ëþáîãî èçîáðàæåíèÿ 
(ðèñ. 1.11), ýòî íå äîïóñêàåòñÿ. 
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Ðèñ. 1.11. Èñõîäíûé ñëîé â èçîáðàæåíèè

Øàã 6. Èçìåíåíèå ñëîÿ Background
Ùåëêíèòå äâà ðàçà ïî ñëîþ â ïàíåëè Layers (Ñëîè) è â 
ïîÿâèâøåìñÿ äèàëîãîâîì îêíå ïðîñòî íàæìèòå êíîïêó OK, 
áîëåå íè÷åãî äåëàòü íå íóæíî. Ïîñëå ýòîãî ñëîé Background 
áóäåò ïåðåèìåíîâàí â ñëîé Layer 0, êðîìå òîãî, ñíèìóòñÿ 
îãðàíè÷åíèÿ, íàêëàäûâàåìûå íà ôîíîâûé ñëîé (ðèñ. 1.12).

Ðèñ. 1.12. Íîâûé ñëîé â èçîáðàæåíèè

Øàã 7. Óäàëåíèå ôîíà
Òåïåðü óäàëÿåì îáëàñòü âîêðóã äåâî÷êè ïðîñòûì íàæàòèåì 
íà êëàâèøó <Delete>. Åñëè ôîí íå èñ÷åç, çíà÷èò, íå áûëî 
ñäåëàíî èíâåðòèðîâàíèå âûäåëåíèÿ. Â ýòîì ñëó÷àå ñëåäóåò 
îòìåíèòü ïîñëåäíåå äåéñòâèå è ïîâòîðèòü øàã 5. Â èòîãå 
äîëæíî ïîëó÷èòüñÿ èçîáðàæåíèå êàê íà ðèñ. 1.13.

Øàã 8. Ñìÿã÷åíèå êðàåâ
Åñëè âîêðóã äåâî÷êè âèäíà òîíêàÿ êàåìêà, îñòàâøàÿñÿ îò 
ôîíà, òî åå ìîæíî óäàëèòü ñëåäóþùèì îáðàçîì. 

• Óäåðæèâàÿ êëàâèøó <Ctrl>, ùåëêàåì ïî ñëîþ Layer 0. 
Ýòî äåéñòâèå âûäåëÿåò âñå îáúåêòû, êîòîðûå ëåæàò íà 
ïðîçðà÷íîì ôîíå. 
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• Èíâåðòèðóåì âûäåëåíèå (<Shift>+<Ctrl>+<I>). 
• Âûáèðàåì ðàäèóñ ðàçìûòèÿ ÷åðåç ìåíþ Select > Feather 

(Âûäåëåíèå > Ïåðî, <Alt>+<Ctrl>+<D>). 
• Óñòàíàâëèâàåì çíà÷åíèå 1-4 ïèêñåëà â çàâèñèìîñòè îò 

ðàçìåðà èçîáðàæåíèÿ. 
• Íàæèìàåì êëàâèøó <Delete>. 

Ïîäîáíàÿ ïðîöåäóðà óäàëÿåò òåìíóþ êàåìêó âîêðóã 
âûäåëåííîé îáëàñòè, âäîáàâîê ñëåãêà ñìÿã÷àåò êðàÿ. Çíà÷åíèå 
ðàäèóñà ðàçìûòèÿ ëó÷øå ïîäîáðàòü ýêñïåðèìåíòàëüíî, 
ïîñêîëüêó ìàëîå çíà÷åíèå íå äàñò íóæíîãî ýôôåêòà, à 
ñëèøêîì áîëüøîå ïðèâåäåò ê óäàëåíèþ ÷àñòè èçîáðàæåíèÿ. 
Â ïðîöåññå óäàëåíèÿ îáëàñòü âûäåëåíèÿ æåëàòåëüíî 
ñêðûòü (<Ctrl>+<H>), ÷òîáû îíà íå ìåøàëà íàáëþäàòü çà 
èçìåíåíèÿìè. ×òîáû âåðíóòü îòîáðàæåíèå âûäåëåíèÿ, ñíîâà 
íàæìèòå íà <Ctrl>+<H>.

Ðèñ. 1.13. Èòîãîâîå èçîáðàæåíèå ñ ïðîçðà÷íîñòüþ

Â çàâåðøåíèè òðåáóåòñÿ ñíÿòü âûäåëåíèå ÷åðåç Select > 
Deselect (Âûäåëåíèå > Ñíÿòü âûäåëåíèå), èëè íàæàâ íà 
êëàâèøó <Ctrl>+<D>. 
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Èñïîëüçîâàíèå
ñëîé-ìàñêè

Ìàñêèðîâàíèå — ñêðûòèå íåíóæíûõ ïèêñåëîâ èçîáðàæåíèÿ —
ÿâëÿåòñÿ âàæíûì ýòàïîì ñîçäàíèÿ ëþáîãî êîëëàæà. 
Ïðèìåíåíèå ñëîé-ìàñêè ïîçâîëÿåò ëåãêî ìàñêèðîâàòü 
íåíóæíûå îáëàñòè, ïðè ýòîì îíè íå óäàëÿþòñÿ è ïðè æåëàíèè 
èõ ìîæíî âîññòàíîâèòü. Êðîìå òîãî, ñ ïîìîùüþ ñëîé-ìàñêè 
ìîæíî ëåãêî ñîçäàâàòü ïëàâíûå êîíòóðû è ãðàäèåíòíûå 
ïåðåõîäû. Êàê è â ñëó÷àå ïðèìåíåíèÿ áûñòðîé ìàñêè, 
òðåáóåòñÿ ïðîéòè íåñêîëüêî øàãîâ, ïðåæäå ÷åì ïîëó÷èòü 
èòîãîâîå âûäåëåíèå.

Øàã 1. Èçìåíåíèå ñëîÿ Background
Ïðåæäå ÷åì íà÷àòü âûäåëÿòü ôèãóðó äåâî÷êè ñ ïîìîùüþ ñëîé-
ìàñêè, íåîáõîäèìî ïðîèçâåñòè ìàíèïóëÿöèþ ñî ñëîåì. Äåëî 
â òîì, ÷òî ñëîé-ìàñêà íå ïðèìåíÿåòñÿ ê ñëîþ Background 
(Ôîí), êîòîðûé óñòàíîâëåí äëÿ èçîáðàæåíèÿ ïî óìîë÷àíèþ 
(ðèñ. 1.11).

Ùåëêíèòå äâà ðàçà ïî ñëîþ â ïàíåëè Layers è â 
ïîÿâèâøåìñÿ äèàëîãîâîì îêíå (ðèñ. 1.14) íàæìèòå êíîïêó 
OK, ïîñëå ÷åãî ñëîé Background áóäåò ïåðåèìåíîâàí â ñëîé 
Layer 0, êðîìå òîãî, ñíèìóòñÿ îãðàíè÷åíèÿ, íàêëàäûâàåìûå íà 
ôîíîâûé ñëîé (ðèñ. 1.12).

Ðèñ. 1.14. Äèàëîãîâàÿ ïàíåëü äëÿ ïåðåèìåíîâàíèÿ ñëîÿ

Øàã 2. Äîáàâëåíèå ñëîé-ìàñêè
Â ïàíåëè Layers íàæìèòå íà êíîïêó ñëîé-ìàñêè, êàê ïîêàçàíî 
íà ðèñ. 1.15. Çàìåòüòå, ÷òî èêîíêà êèñòî÷êè âîçëå èçîáðàæåíèÿ 
ñëîÿ â ïàíåëè Layers ñìåíèëàñü íà èêîíêó ñëîé-ìàñêè 
(ðèñ. 1.16). Ýòî çíà÷èò, ÷òî âû òåïåðü íàõîäèòåñü â ðåæèìå 
ìàñêèðîâàíèÿ. 

Øàã 3. Ðåäàêòèðîâàíèå ìàñêè
Âûáèðàåì èíñòðóìåíò Brush, óñòàíàâëèâàåì ÷åðíûé öâåò, 
ïîäõîäÿùèé ðàçìåð êèñòè è àêêóðàòíî çàêðàøèâàåì îáëàñòü, 
êîòîðàÿ íàì íå íóæíà. Åñëè òàêàÿ îáëàñòü äîñòàòî÷íî âåëèêà, 
òî ëó÷øå âîñïîëüçîâàòüñÿ èíñòðóìåíòîì Lasso, âûäåëèòü 
ôðàãìåíò è çàêðàñèòü åãî ÷åðíûì öâåòîì. Ïðè èñïîëüçîâàíèè 
ñëîé-ìàñêè õàðàêòåðíî òî, ÷òî èñõîäíîå èçîáðàæåíèå îñòàåòñÿ 

 — ñëîé-ìàñêà, 
êíîïêà äîñòóïíà íà 
ïàíåëè Layers.

Ñëîé-ìàñêà 
ïðåäíàçíà÷åíà äëÿ 
âûäåëåíèÿ îáëàñòè 
èçîáðàæåíèÿ â ñëîå, à 
òàêæå äëÿ ìàñêèðîâàíèÿ 
ôðàãìåíòîâ 
èçîáðàæåíèÿ. Ìàñêà 
õðàíèòñÿ âìåñòå ñî 
ñëîåì è ïðåäñòàâëÿåò 
ñîáîé ÷åðíî-áåëûé 
ðèñóíîê. ×åðíûé öâåò 
ñêðûâàåò ôðàãìåíò 
ñëîÿ, áåëûé öâåò 
ïîêàçûâàåò åãî, 
à îòòåíêè ñåðîãî 
óñòàíàâëèâàþò 
ðàçëè÷íîãî óðîâíÿ 
ïðîçðà÷íîñòü. 
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íåòðîíóòûì, ïîýòîìó ïðè îøèáêå íóæíî ëèøü óñòàíîâèòü 
áåëûé öâåò êèñòè è âîññòàíîâèòü ìàñêèðîâàííûå ó÷àñòêè. 
Èñïîëüçîâàíèå êèñòåé ñ ìÿãêèìè êðàÿìè ïîçâîëÿåò ïîëó÷èòü 
ïîëóïðîçðà÷íûå ãðàíèöû è ïëàâíûå ïåðåõîäû.

Ðèñ. 1.15. Äîáàâëåíèå ñëîÿ-ìàñêè äëÿ ñëîÿ Layer 0

Ðèñ. 1.16. Ìàñêà äëÿ ñëîÿ

Ïðîçðà÷íàÿ îáëàñòü ïî óìîë÷àíèþ îòîáðàæàåòñÿ â âèäå 
êëåò÷àòîãî ôîíà, íà êîòîðîì òåðÿþòñÿ ìåëêèå äåòàëè. Òàê 
÷òî ðåêîìåíäóåòñÿ ñîçäàòü íîâûé ñëîé, çàëèòü åãî áåëûì 
èëè ÷åðíûì öâåòîì è ïîìåñòèòü òàêîé ñëîé ïîä òåêóùèé 
ìàñêèðóåìûé ñëîé (ðèñ. 1.16). Â òàêîì ñëó÷àå îáëåã÷àåòñÿ 
âûäåëåíèå ôèãóðû è âîçðàñòàåò òî÷íîñòü ðåçóëüòàòà. 

Øàã 4. Óäàëåíèå ëèøíåãî
Â îêîí÷àòåëüíîì âàðèàíòå ìàñêèðîâàííûå îáëàñòè óæå íå 
íóæíû, è èõ ìîæíî óäàëèòü. Äëÿ ýòîãî ùåëêàåì ïðàâîé 
êíîïêîé ìûøè ïî èçîáðàæåíèþ ñëîé-ìàñêè è â êîíòåêñòíîì 

Ñîâåò
Äëÿ áûñòðîãî 
çàêðàøèâàíèÿ 
âûäåëåííîé îáëàñòè 
öâåòîì ïåðåäíåãî 
ïëàíà èñïîëüçóéòå 
êîìáèíàöèþ êëàâèø 
<Alt>+<Backspace> 
èëè <Alt>+<Delete>. 
Äëÿ çàêðàøèâàíèÿ 
âûäåëåííîé îáëàñòè 
ôîíîâûì öâåòîì 
âîñïîëüçóéòåñü 
êîìáèíàöèåé 
<Ctrl>+<Backspace> 
èëè <Ctrl>+<Delete>.
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ìåíþ âûáèðàåì ïóíêò Apply Layer Mask (Ïðèìåíèòü ñëîé-
ìàñêó), îí ñïåöèàëüíî âûäåëåí íà ðèñ. 1.17. 

Ðèñ. 1.17. Óäàëåíèå ìàñêèðîâàííîé îáëàñòè

Íåîáõîäèìîñòè â ôîíîâîì ñëîå Layer 0 òàêæå íåò, ïîýòîìó 
åãî ìîæíî óäàëèòü. Îêîí÷àòåëüíî äîëæíî ïîëó÷èòüñÿ 
èçîáðàæåíèå, ïðåäñòàâëåííîå íà ðèñ. 1.13.

Âîçìîæíîñòè ñëîé-ìàñîê íå îãðàíè÷èâàþòñÿ âûäåëåíèåì 
îáëàñòåé íà ôîòîãðàôèÿõ, íî ñ ýòîé çàäà÷åé îíè ñïðàâëÿþòñÿ 
ïðåâîñõîäíî. Ê òîìó æå â ëþáîé ìîìåíò ìîæíî âåðíóòüñÿ ê 
ïåðâîíà÷àëüíîìó èçîáðàæåíèþ è ïîâòîðèòü íåóäà÷íûé øàã.

Íàëîæåíèå è 
òðàíñôîðìàöèÿ

ñëîåâ

Ðåäêî êîãäà ïîëó÷àåòñÿ, ÷òîáû èñõîäíûå ôîòîãðàôèè èìåëè 
íóæíûé ìàñøòàá, âäîáàâîê ñ èçîáðàæåíèÿìè áîëüøîãî 
ðàçìåðà óäîáíåå ðàáîòàòü. Ïîýòîìó èõ ïðèõîäèòñÿ óìåíüøàòü, 
ïðèâîäÿ âñå èçîáðàæåíèÿ ê îäíîìó ìàñøòàáó. Â ïðîãðàììå 
Photoshop äëÿ ýòîé öåëè ïðèìåíÿåòñÿ èíñòðóìåíò Transform 
(Òðàíñôîðìàöèÿ). Â äàííûé ìîìåíò òðåáóåòñÿ ñâåñòè âñå 
èñõîäíûå èçîáðàæåíèÿ â îäíî è îòìàñøòàáèðîâàòü èõ ñîãëàñíî 
íàøèì ïðåäïî÷òåíèÿì. 

Øàã 1. Íàëîæåíèå èçîáðàæåíèé
Îòêðûâàåì èçîáðàæåíèå äåâî÷êè íà ïðîçðà÷íîì ôîíå 
(ðèñ. 1.13) è ôîòîãðàôèþ ãðèáà (ðèñ. 1.1) è íàêëàäûâàåì 
èçîáðàæåíèÿ äðóã íà äðóãà â âèäå ñëîåâ. Â èòîãå äîëæíî 
ïîëó÷èòüñÿ äâà ñëîÿ, êàê ïîêàçàíî íà ðèñ. 1.18. 
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Ðèñ. 1.18. Èñõîäíûå ñëîè â êîëëàæå

Äëÿ ñîçäàíèÿ ïîäîáíîãî íàáîðà ñëîåâ è ñîâìåùåíèÿ ðàçíûõ 
èçîáðàæåíèé åñòü íåñêîëüêî ñïîñîáîâ. Äàëåå ïðèâåäåíû äâà 
ïîïóëÿðíûõ ñïîñîáà.

Ñïîñîá 1
• Âûäåëÿåì âñå èçîáðàæåíèå ñ äåâî÷êîé ÷åðåç ìåíþ 

Select > All (Âûäåëåíèå > Âûäåëèòü âñå) èëè èñïîëüçóåì 
êîìáèíàöèþ êëàâèø <Ctrl>+<A>.

• Êîïèðóåì ñîäåðæèìîå âûäåëåííîé îáëàñòè â áóôåð Edit > 
Copy (Ïðàâêà > Êîïèðîâàòü èëè <Ctrl>+<C>). Çàìåòüòå, 
÷òî òàê êîïèðóåòñÿ ñîäåðæèìîå òîëüêî òåêóùåãî ñëîÿ, 
äëÿ òîãî, ÷òîáû ñêîïèðîâàòü â áóôåð âñå ñëîè, ñëåäóåò 
èñïîëüçîâàòü Edit > Copy Merged (Ïðàâêà > Êîïèðîâàòü 
ñîâìåñòíî, <Shift>+<Ctrl>+<C>). 

• Ïåðåõîäèì ê èçîáðàæåíèþ ñ ãðèáîì è âûáèðàåì ïóíêò 
Edit > Paste (Ïðàâêà > Âñòàâèòü, <Ctrl>+<V>). Íîâûé 
ñëîé, ñîäåðæàùèé èçîáðàæåíèå äåâî÷êè, áóäåò ñîçäàí 
àâòîìàòè÷åñêè.

Ñïîñîá 2
• Îòêðûâàåì îáà ôàéëà è ðàñïîëàãàåì îêíà ñ èçîáðàæåíèÿìè 

â ðàáî÷åé îáëàñòè òàê, ÷òîáû îíè áûëè âèäíû 
îäíîâðåìåííî.

• Â ïàíåëè Layers ùåëêàåì ïî ñëîþ ñ äåâî÷êîé è, íå 
îòïóñêàÿ êíîïêó ìûøè, òàùèì ñëîé ê èçîáðàæåíèþ ñ 
ãðèáîì.

• Êàê òîëüêî âîêðóã ôîòîãðàôèè ãðèáà ïîÿâèëàñü öâåòíàÿ 
ãðàíèöà (ðèñ. 1.19), êíîïêó ìûøè ìîæíî îòïóñêàòü. 
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Ðèñ. 1.19. Ïåðåòàñêèâàíèå ñëîÿ èç îäíîãî èçîáðàæåíèÿ â äðóãîå

Øàã 2. Òðàíñôîðìàöèÿ ñëîÿ
Îêîí÷àòåëüíî äîëæíî ïîëó÷èòüñÿ èçîáðàæåíèå ñ äâóìÿ 
ñëîÿìè, ãäå ñëîé ñ äåâî÷êîé ðàñïîëàãàåòñÿ ïîâåðõ ñëîÿ ñ 
ãðèáîì (ðèñ. 1.18). Îñòàëîñü òîëüêî èçìåíèòü ìàñøòàá è 
ðàñïîëîæèòü ôðàãìåíòû êîëëàæà â íóæíûõ ìåñòàõ.

Âûáèðàåì èíñòðóìåíò Free Transform (Image > Free 
Transform, Ñâîáîäíàÿ òðàíñôîðìàöèÿ, <Ctrl>+<T>) 
è, óäåðæèâàÿ êíîïêó <Shift>, òÿíåì çà îäèí óãîëîê 
îòîáðàæàåìîãî ïðÿìîóãîëüíèêà. Êíîïêà <Shift> íóæíà, 
÷òîáû ñîõðàíèòü ïðîïîðöèè èçîáðàæåíèÿ, èíà÷å ïîÿâÿòñÿ 
íåæåëàòåëüíûå èñêàæåíèÿ. Ìîæíî îäíîâðåìåííî ïåðåìåùàòü 
âèäîèçìåíÿåìóþ îáëàñòü â íóæíîå ìåñòî. ×òîáû ïðèìåíèòü 
ýôôåêò òðàíñôîðìèðîâàíèÿ íàæìèòå êíîïêó <Enter> èëè 
äâàæäû ùåëêíèòå ìûøêîé âíóòðè îáëàñòè òðàíñôîðìàöèè. 

Ðåçóëüòàò èñïîëüçîâàíèÿ òðàíñôîðìàöèè ïðîäåìîíñòðèðîâàí 
íà ðèñ 1.20. 
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Ðèñ. 1.20. Ðåçóëüòàò òðàíñôîðìàöèè ñëîåâ

Ìû ïîäîøëè óæå ê ôèíàëó, è ÷òîáû ôîòîãðàôèÿ áûëà 
áîëåå ïðàâäîïîäîáíà, òðåáóåòñÿ äîáàâèòü åùå íåñêîëüêî 
øòðèõîâ, â ÷àñòíîñòè ñîçäàòü òåíü. Áåç ýòîãî ðàáîòà íå áóäåò 
çàêîí÷åííîé è âñåãî ëèøü ïîõîæà íà àïïëèêàöèþ, à íèêàê íå 
íà ðåàëèñòè÷íûé êîëëàæ.

Äîáàâëåíèå 
òåíè

Èñïîëüçîâàíèå òåíè ïðè ñîçäàíèè êîëëàæà ïîçâîëÿåò ïðèäàòü 
èçîáðàæåíèÿì îáúåì è ãëóáèíó, è ïîâûøàåò ðåàëèñòè÷íîñòü 
ðåçóëüòàòà. Áåç ýòîãî íåáîëüøîãî øòðèõà ÷åëîâåê 
ïîäñîçíàòåëüíî áóäåò îòêàçûâàòüñÿ ïðèíÿòü ôîòîãðàôèþ êàê 
«íàñòîÿùóþ». 

Äëÿ ñîçäàíèÿ òåíè ñóùåñòâóåò äâà îñíîâíûõ ñïîñîáà, 
êîòîðûå ðàññìîòðåíû äàëåå.

Èñïîëüçîâàíèå ñòèëÿ ñëîÿ
Ê ñîäåðæèìîìó ñëîÿ ëåãêî äîáàâèòü òåíü, åñëè âîñïîëüçîâàòüñÿ 
ñòèëÿìè ñëîÿ. Äëÿ ýòîãî â ïàíåëè Layers ïðèìåíÿåòñÿ 
ñïåöèàëüíàÿ êíîïêà . Âûäåëèòå ñëîé ñ äåâî÷êîé è íàæìèòå 
ýòó êíîïêó. Â îòêðûâøåìñÿ ñïèñêå ñëåäóåò âûáðàòü ïóíêò 
Drop Shadow (Äîáàâèòü òåíü), êàê ïîêàçàíî íà ðèñ. 1.21. 
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Ðèñ. 1.21. Äîáàâëåíèå òåíè ê ñîäåðæèìîìó ñëîÿ

Â äèàëîãîâîì îêíå Layer Style (Ñòèëü ñëîÿ) ñëåäóåò óêàçàòü 
ïàðàìåòðû òåíè, íàïðèìåð, êàê ïîêàçàíî íà ðèñ. 1.23. 
Õàðàêòåðèñòèêè òåíè çàâèñÿò îò ìíîæåñòâà ïàðàìåòðîâ, è 
áóäóò ìåíÿòüñÿ â çàâèñèìîñòè îò òåêóùåãî èçîáðàæåíèÿ. 

Ïðèìåíÿåìûå ê ñëîþ ýôôåêòû îòîáðàæàþòñÿ â ïàíåëè 
Layers (ðèñ. 1.22), ãäå èõ ìîæíî âêëþ÷àòü, âûêëþ÷àòü èëè 
èçìåíÿòü ïàðàìåòðû ñòèëÿ.

 

Ðèñ. 1.22. Âèä ñëîåâ 
ïðè èñïîëüçîâàíèè 
ñòèëÿ ñëîÿ
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Ðèñ. 1.23. Ïàðàìåòðû òåíè, çàäàâàåìûå ÷åðåç ñòèëè ñëîÿ

Îêîí÷àòåëüíûé âèä êîëëàæà ñ óêàçàííûìè ïàðàìåòðàìè 
òåíè ïîêàçàí íà ðèñ. 1.24.

Ðèñ. 1.24. Ôîòîãðàôèÿ ïîñëå äîáàâëåíèÿ òåíè
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Ê ïðåèìóùåñòâàì óêàçàííîãî ñïîñîáà ñîçäàíèÿ òåíè 
îòíîñèòñÿ åãî ïðîñòîòà, à òàêæå áîëüøîå ÷èñëî ðàçëè÷íûõ 
ïàðàìåòðîâ òåíè, êîòîðûå â ëþáîé ìîìåíò ìîæíî èçìåíèòü. 
Îäíàêî òåíü ïðèìåíÿåòñÿ êî âñåìó ñëîþ, ÷òî íå âñåãäà 
òðåáóåòñÿ. Îáðàòèòå, íàïðèìåð, âíèìàíèå íà ãîëîâó è ïðàâóþ 
ðóêó äåâî÷êè. Îíè îòáðàñûâàþò òåíü, ïðè÷åì ñðàçó íà ëèñòüÿ, 
÷òî îáû÷íî ïðîèñõîäèò òîëüêî ïðè ñúåìêå ñî âñòðîåííîé 
âñïûøêîé. Æåëàòåëüíî òåíü ïîäïðàâèòü èëè óáðàòü â 
íåêîòîðûõ ìåñòàõ, íî íàïðÿìóþ ñäåëàòü ýòî íå óäàñòñÿ. Äëÿ 
ðåäàêòèðîâàíèÿ òåíè â äàííîì ñëó÷àå ìîæíî èñïîëüçîâàòü äâà 
ìåòîäà. 

Ìåòîä 1
1. Ñîçäàòü êîïèþ ñëîÿ ñ äåâî÷êîé è ïîìåñòèòü ñëîé íèæå 

îðèãèíàëà. 
2. Ïðèìåíèòü òåíü ê íîâîìó ñëîþ (ðèñ. 1.25).
3. Â òåõ ìåñòàõ, ãäå òåíü ñëåäóåò óáðàòü, èíñòðóìåíòîì Erase 

(Ëàñòèê) òðåáóåòñÿ «ñòåðåòü» ÷àñòü äåâî÷êè. 

Ðèñ. 1.25. Ñòðóêòóðà ñëîåâ äëÿ ðåäàêòèðîâàíèÿ òåíè

Ïîñêîëüêó òåíü ïðèìåíÿåòñÿ ê íèæåëåæàùåìó ñëîþ, òî 
ëþáûå ìàíèïóëÿöèè ñ íèì áóäóò ñîêðûòû âåðõíèì ñëîåì ñ 
äåâî÷êîé, è âèäíà òîëüêî âûñòóïàþùàÿ òåíü. 

Ìåòîä 2
1. Ùåëêàåì ïðàâîé êíîïêîé ìûøè ïî ýëåìåíòó Effects 

(Ýôôåêòû) â ïàíåëè Layers. 
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2. Â îòêðûâøåìñÿ ìåíþ âûáèðàåì ïóíêò Create Layers (Ñîçäàòü 
ñëîé), êàê ïîêàçàíî íà ðèñ. 1.26. Ïîñëå ÷åãî âûâîäèòñÿ îêíî 
ñ ïðåäóïðåæäåíèåì, ÷òî íåêîòîðûå àñïåêòû ýôôåêòîâ íå 
ìîãóò áûòü ïðåîáðàçîâàíû â ñëîé. Ñëåäóåò íàæàòü êíîïêó 
ÎÊ, è ïîÿâèòñÿ íîâûé ñëîé, ñîäåðæàùèé òåíü. Òåïåðü åãî 
ìîæíî ðåäàêòèðîâàòü, êàê çàáëàãîðàññóäèòñÿ.  

Ðèñ. 1.26. Ïðåîáðàçîâàíèå ýôôåêòà â ñëîé

Ñîçäàíèå òåíè ñ ïîìîùüþ ñëîåâ è ôèëüòðîâ
Â ðàííèõ âåðñèÿõ ïðîãðàììû Photoshop íå áûëî ñòèëÿ ñëîÿ, 
ïîýòîìó òåíü ïðèõîäèëîñü äîáàâëÿòü äðóãèì ñïîñîáîì, 
êîòîðûé ïîêàçàí äàëåå. 

Âíà÷àëå äåëàåì êîïèþ ñëîÿ ñ äåâî÷êîé è ðàñïîëàãàåì åãî 
íèæå îðèãèíàëà. Äëÿ óäîáñòâà ìîæíî îáîçâàòü ñëîè, íàïðèìåð 
êàê ïîêàçàíî íà ðèñ. 1.27. 

Çàòåì ïåðåõîäèì íà ñëîé ñ èìåíåì Shadow, âûäåëÿåì åãî 
ñîäåðæèìîå è çàëèâàåì ÷åðíûì öâåòîì.

Âûáèðàåì èíñòðóìåíò Move (Ïåðåìåùåíèå, êëàâèøà äëÿ 
âûçîâà <V>) è ñäâèãàåì ñëîé ñ òåíüþ â íóæíóþ ñòîðîíó. 
Çàîäíî ñëåäóåò èçìåíèòü ïðîçðà÷íîñòü ñëîÿ íà 20-40% 
(ðèñ. 1.28).

 

Ñîâåò
Áûñòðî âûäåëèòü 
ñîäåðæèìîå ñëîÿ 
ìîæíî, ùåëêíóâ ïî 
íåìó è óäåðæèâàÿ ïðè 
ýòîì êëàâèøó <Crtrl>. 
Äëÿ áûñòðîé çàëèâêè 
ñëîÿ ÷åðíûì öâåòîì, 
íàæìèòå êëàâèøó 
<D>, ýòî ïåðåêëþ÷èò 
öâåòà ïåðåäíåãî è 
çàäíåãî ïëàíà íà 
÷åðíûé è áåëûé. 
Çàòåì âîñïîëüçóéòåñü 
êîìáèíàöèåé 
<Alt>+<Backspace> 
èëè <Alt>+<Delete>. 
Âûäåëåííàÿ îáëàñòü 
áóäåò çàëèòà ÷åðíûì 
öâåòîì.
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Ðèñ. 1.27. Ðàñïîëîæåíèå ñëîåâ ïðè ñîçäàíèè òåíè

Ðèñ. 1.28. Èñïîëüçîâàíèå ïðîçðà÷íîñòè äëÿ ñëîÿ ñ òåíüþ

Òåïåðü íóæíî ñìÿã÷èòü êðàÿ òåíè, äëÿ ÷åãî âîñïîëüçóåìñÿ 
ôèëüòðîì Ðàçìûòèå ïî Ãàóññó (Filter > Blur > Gaussian 
Blur, Ôèëüòð > Ðàçìûòèå > Ðàçìûòèå ïî Ãàóññó). Ðàäèóñ 
ðàçìûòèÿ, êîòîðûé ïðèìåíÿåòñÿ â ôèëüòðå, çàâèñèò îò ðàçìåðà 
èçîáðàæåíèÿ è òðåáóåìîé ìÿãêîñòè êðàÿ òåíè. 

Îêîí÷àòåëüíî íàñòðàèâàåì ïîëîæåíèå òåíè è åå 
ïðîçðà÷íîñòè, à òàêæå ñòèðàåì òåíü â òåõ ìåñòàõ, ãäå îíà íå 

— èíñòðóìåíò Move.

Ïåðåìåùåíèå ñëîÿ ñ 
óäåðæèâàåìîé êëàâèøåé 
<Alt> ñîçäàåò êîïèþ 
ñëîÿ. 
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òðåáóåòñÿ. Åñëè ïëàíèðóåòñÿ äàëüíåéøåå ïåðåìåùåíèå ñëîåâ, 
òî ðåêîìåíäóåòñÿ ñâÿçàòü èõ ìåæäó ñîáîé, ÷òîáû äåâî÷êà è åå 
òåíü ñäâèãàëèñü îäíîâðåìåííî. 

Íà ðèñ. 1.29 ïîêàçàíî èñïîëüçîâàíèå ñëîÿ äëÿ ñîçäàíèÿ 
òåíè. Ïîëîæåíèå äåâî÷êè è òåíè íåñêîëüêî èçìåíåíî äëÿ 
ëó÷øåãî ðåçóëüòàòà.

 

Ðèñ. 1.29. Îêîí÷àòåëüíîå ïðèìåíåíèå ñëîÿ ñ òåíüþ
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Êîëëàæ 2
Ïðåâðàùåíèå

Ìîäåëü Åêàòåðèíà Àáðàìîâà
Ôîòî Àíàñòàñèÿ Ñòàðîâàòîâà
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Äëÿ ñîçäàíèÿ ïîäîáíîãî êîëëàæà ïîíàäîáèòñÿ âñåãî äâà 
èçîáðàæåíèÿ — ôîòîãðàôèÿ äåâî÷êè (ðèñ. 2.1) è îòäåëüíîãî 
äåðåâà (ðèñ. 2.2). Ñàì ïðîöåññ ñîçäàíèÿ êîëëàæà äîñòàòî÷íî 
ïðîñò è òðåáóåò òîëüêî àêêóðàòíîñòè.

Ðèñ. 2.1. Èñõîäíàÿ ôîòîãðàôèÿ 
äåâî÷êè

Ðèñ. 2.2. Ôîòîãðàôèÿ 
äåðåâà

Óäàëåíèå ôîíà Äëÿ íà÷àëà ñëåäóåò î÷èñòèòü ôîòîãðàôèþ äåðåâà îò ôîíà, 
÷òîáû èçîáðàæåíèå ìîæíî áûëî ïîìåñòèòü íà äðóãîé 
ôîí. Íàì ïîòðåáóåòñÿ òîëüêî âåðõóøêà äåðåâà, êîòîðàÿ 
ðàñïîëàãàåòñÿ íà îòíîñèòåëüíî îäíîòîííîì ãîëóáîì íåáå, 
çà ñ÷åò ýòîãî ïðîöåññ âûäåëåíèÿ ìîæíî àâòîìàòèçèðîâàòü ñ 
ïîìîùüþ èíñòðóìåíòîâ Magic Wand (Âîëøåáíàÿ ïàëî÷êà) èëè 
Magic Erase (Âîëøåáíûé ëàñòèê). 

Ðèñ. 2.3. Ôðàãìåíò 
ôîòîãðàôèè ñ äåðåâîì äëÿ 
óäàëåíèÿ ôîíà
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Â ïåðâóþ î÷åðåäü ïðèìåíÿåì èíñòðóìåíò Crop (Îáðåçàíèå), 
÷òîáû óäàëèòü ëèøíåå, â èòîãå äîëæíî ïîëó÷èòüñÿ 
èçîáðàæåíèå, êàê íà ðèñ. 2.3. 

Ïåðåä òåì, êàê âûäåëèòü è óäàëèòü ôîí, òðåáóåòñÿ 
ïåðåèìåíîâàòü ñëîé Background, èíà÷å ïðîçðà÷íûå ó÷àñòêè 
ñîçäàòü íå óäàñòñÿ. Äàëåå ðàññìîòðèì äâà ñïîñîáà óäàëåíèÿ 
îäíîòîííûõ ó÷àñòêîâ íåáà.

Èñïîëüçîâàíèå èíñòðóìåíòà Magic Wand
Èíñòðóìåíò Magic Wand (Âîëøåáíàÿ ïàëî÷êà, êëàâèøà äëÿ 
âûçîâà <W>) ïîçâîëÿåò âûäåëÿòü îäíîöâåòíóþ îáëàñòü â 
èçîáðàæåíèè. Ýòîò èíñòðóìåíò óäîáíî èñïîëüçîâàòü, êîãäà 
òðåáóåòñÿ âûäåëèòü ïèêñåëû, áëèçêèå ïî öâåòó. Äèàïàçîí 
öâåòà ðåãóëèðóåòñÿ ïàðàìåòðîì Tolerance (Äîïóñê), îí ìîæåò 
èçìåíÿòüñÿ îò 0 äî 255. ×åì áîëüøå ââåäåííîå ÷èñëî, òåì 
øèðå äèàïàçîí âûäåëÿåìîãî öâåòà. Ñîîòâåòñòâåííî, ÷åì ÷èñëî 
ìåíüøå, òåì òî÷íåå ìîæíî óêàçàòü òðåáóåìûé öâåò. Â ëþáîì 
ñëó÷àå äîïóñê ïîäáèðàåòñÿ ýêñïåðèìåíòàëüíî, â çàâèñèìîñòè 
îò èñõîäíîãî èçîáðàæåíèÿ. Çíà÷åíèå Tolerance ââîäèòñÿ â 
ïàðàìåòðàõ èíñòðóìåíòà, êàê ïîêàçàíî íà ðèñ. 2.4. 

Ðèñ. 2.4. Ïàðàìåòðû èíñòðóìåíòà Magic Wand

Òàêæå ñëåäóåò óñòàíîâèòü ôëàæîê âîçëå ïàðàìåòðà Anti-
aliased (Ñãëàæåííûå êðàÿ), ÷òîáû îáåñïå÷èòü ìÿãêîñòü 
âûäåëåíèÿ îáëàñòè. Ïîñêîëüêó íàì òðåáóåòñÿ óäàëèòü âåñü 
ôîí, òî ñëåäóåò óáðàòü ôëàæîê ñ ïàðàìåòðà Contiguous 
(Íåïðåðûâíàÿ îáëàñòü). Â ïðîòèâíîì ñëó÷àå áóäåò âûäåëåíà 
òîëüêî îáëàñòü, îãðàíè÷åííàÿ ïèêñåëàìè äðóãîãî öâåòà. 

Ðèñ. 2.5. Âûäåëåííàÿ îáëàñòü â èçîáðàæåíèè

— èíñòðóìåíò Crop.

Ïðåäíàçíà÷åí äëÿ 
óäàëåíèÿ ÷àñòè 
èçîáðàæåíèÿ.

— èíñòðóìåíò Magic 
Wand.

Èñïîëüçîâàíèå 
èíñòðóìåíòà Magic 
Wand îäíîâðåìåííî 
ñ íàæàòîé êëàâèøåé 
<Shift> ïîçâîëÿåò 
äîáàâëÿòü îáëàñòü 
ê ñóùåñòâóþùåìó 
âûäåëåíèþ. 
Óäåðæèâàíèå 
êëàâèøè <Alt> âî 
âðåìÿ ïðèìåíåíèÿ 
ýòîãî èíñòðóìåíòà  
ïîçâîëÿåò âû÷èòàòü 
èç ñóùåñòâóþùåãî 
âûäåëåíèÿ 
îáîçíà÷åííóþ îáëàñòü. 
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Ïîñëå âûäåëåíèÿ îáëàñòè åå íàäî óäàëèòü íàæàòèåì 
íà êëàâèøó <Delete>. ×òîáû ðåçóëüòàò áûë çàìåòíåå, 
ðåêîìåíäóåòñÿ ñîçäàòü íîâûé ñëîé, çàëèòü åãî îäíîðîäíûì 
öâåòîì (íàïðèìåð, ÷åðíûì) è ïîäëîæèòü ïîä ñëîé ñ 
èçîáðàæåíèåì äåðåâà (ðèñ. 2.6).

Ðèñ. 2.6. Èçîáðàæåíèå ñ óäàëåííûì ôîíîì

Êàê âèäíî èç ðèñ. 2.6, ñèíÿÿ êàåìêà âîêðóã âåòîê îñòàåòñÿ 
â ëþáîì ñëó÷àå. Îò íåå ìîæíî èçáàâèòüñÿ, åñëè ïîâûñèòü 
çíà÷åíèå Tolerance èíñòðóìåíòà Magic Wand èëè èçìåíèòü 
ðàäèóñ ðàçìûòèÿ ÷åðåç ìåíþ Select > Feather (Âûäåëåíèå > 
Ïåðî, <Alt>+<Ctrl>+<D>). 

Â íåêîòîðûõ ñëó÷àÿõ âûäåëåíèå îáúåêòîâ óïðîùàåòñÿ, åñëè 
âîñïîëüçîâàòüñÿ ïàíåëüþ Channel (Êàíàëû). Â ðåæèìå RGB 
ïðåäñòàâëåíî òðè êàíàëà — Red (Êðàñíûé), Green (Çåëåíûé) 
è Blue (Ñèíèé). Ïî î÷åðåäè âêëþ÷àåì êàæäûé êàíàë è 
àíàëèçèðóåì åãî (ðèñ. 2.7). 

à. Êàíàë Red á. Êàíàë Green â. Êàíàë Blue

Ðèñ. 2.7. Âèä ôîòîãðàôèè â ðàçíûõ êàíàëàõ

Ñàìûì ïîäõîäÿùèì ïî êîíòðàñòíîñòè ÿâëÿåòñÿ êàíàë Blue, 
â íåì è ïðèìåíÿåì âûäåëåíèå ñ ïîìîùüþ èíñòðóìåíòà Magic 
Wand.
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Èñïîëüçîâàíèå èíñòðóìåíòà Magic Erase
Èíñòðóìåíò Magic Erase (Âîëøåáíûé ëàñòèê) ñòèðàåò ïèêñåëû 
áëèçêèå ïî öâåòó. Åñëè ìû ðàáîòàåì ñî ñëîåì Background èëè 
ñî ñëîåì, ïðîçðà÷íîñòü íà êîòîðîì çàáëîêèðîâàíà, ïèêñåëû 
çàìåíÿòñÿ íà ôîíîâûé öâåò. Âî âñåõ îñòàëüíûõ ñëó÷àÿõ ìû 
ïîëó÷èì ïðîçðà÷íóþ îáëàñòü. 

Ïðèíöèï ðàáîòû ñ èíñòðóìåíòîì Magic Erase íàïîìèíàåò 
ðàáîòó ñ èíñòðóìåíòîì Magic Wand. À èìåííî, âíà÷àëå 
óñòàíàâëèâàåì ïîäõîäÿùåå çíà÷åíèå Tolerance, âêëþ÷àåì 
ôëàæîê Anti-aliased äëÿ ñîçäàíèÿ ïëàâíûõ ãðàíèö, óáèðàåì 
ôëàæîê ñ ïàðàìåòðà Contiguous äëÿ îäíîâðåìåííîãî óäàëåíèÿ 
âñåãî ôîíà, ïîñëå ÷åãî ùåëêàåì ïî ôîòîãðàôèè â ðàéîíå íåáà. 
Åñëè ñëîé Background áûë ïðåäâàðèòåëüíî ïåðåèìåíîâàí, ìû 
ïîëó÷èì ïðîçðà÷íûå ó÷àñòêè â íóæíûõ ìåñòàõ. 

— èíñòðóìåíò Magic 
Erase.

Ïî ñâîåìó äåéñòâèþ 
ïîõîæ íà èíñòðóìåíò 
Magic Wand, íî â 
îòëè÷èå îò íåãî, íå 
âûäåëÿåò îáëàñòü, à 
ñòèðàåò åå.

Íàëîæåíèå è 
òðàíñôîðìàöèÿ 

ñëîåâ

Â èòîãå ìàíèïóëÿöèé ñ ôîòîãðàôèåé äåðåâà, ïîëó÷àåì 
èçîáðàæåíèå íà ïðîçðà÷íîì ôîíå. Ïåðåíîñèì ñëîé íà 
ôîòîãðàôèþ äåâî÷êè, ðàçâîðà÷èâàåì åãî íà 90 ãðàäóñîâ ïðîòèâ 
÷àñîâîé ñòðåëêè (Edit > Transform > Rotate 90° CCW, Ïðàâêà > 
Òðàíñôîðìàöèÿ > Âðàùàòü 90° Ïð×Ñ) è ìàñøòàáèðóåì 
ñîãëàñíî ñâîèì ïðåäïî÷òåíèÿì (ðèñ. 2.8).

Ðèñ. 2.8. Íàëîæåíèå ñëîåâ
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Èçìåíåíèå 
öâåòà

Öâåò äåðåâà íà íîâîì ñëîå ñëèâàåòñÿ ñ ôîíîì, ïîýòîìó 
åãî íåîáõîäèìî «ïåðåêðàñèòü». Â ïðîãðàììå Photoshop äëÿ 
ýòîãî ñóùåñòâóåò ìíîæåñòâî ñðåäñòâ, çäåñü ìû íå áóäåì èõ 
ïåðå÷èñëÿòü, à ïðèâåäåì ëèøü îäèí ñïîñîá, ñâÿçàííûé ñ 
êîððåêòèðîâî÷íûìè ñëîÿìè è èíñòðóìåíòîì Hue/Saturation. 

Íàæèìàåì íà êíîïêó Adjustment layers (Êîððåêòèðîâî÷íûé 
ñëîé) â ïàíåëè Layers è â îòêðûâøåìñÿ ñïèñêå âûáèðàåì 
ïóíêò Hue/Saturation... (ðèñ. 2.9).

Ðèñ. 2.9. Ñîçäàíèå êîððåêòèðîâî÷íîãî ñëîÿ

Ïîñëå ÷åãî îòêðûâàåòñÿ îêíî èíñòðóìåíòà Hue/Saturation, ñ 
ïîìîùüþ êîòîðîãî ìû óñòàíàâëèâàåì íîâûé öâåò ñîäåðæèìîãî 
ñëîÿ, êàê ïîêàçàíî íà ðèñ. 2.10. Âñåãäà ìîæíî èçìåíèòü ýòè 
ïàðàìåòðû, åñëè äâàæäû ùåëêíóòü ïî çíà÷êó ñëîÿ â ïàíåëè 
Layers. 

Ïî óìîë÷àíèþ êîððåêòèðîâî÷íûé ñëîé âîçäåéñòâóåò 
íà âñå íèæåëåæàùèå ñëîè, ïîýòîìó ôîí òàêæå ñòàíåò 
êðàñíîãî îòòåíêà. Ïîäîáíîãî ýôôåêòà îïàñàòüñÿ íå ñòîèò, 
ïîñêîëüêó ýòî ëåãêî ðåãóëèðóåòñÿ. Òðåáóåòñÿ ñãðóïïèðîâàòü 
êîððåêòèðîâî÷íûé ñëîé ñ ïðåäûäóùèì ÷åðåç ïóíêò 
ìåíþ Layer > Group with Previous (Ñëîé > Ãðóïïèðîâàòü ñ 
ïðåäûäóùèì, <Ctrl>+<G>). Àíàëîãè÷íîãî ýôôåêòà ìîæíî 
äîñòè÷ü, åñëè ùåëêíóòü ïî ðàçäåëèòåëüíîé ëèíèè ìåæäó 
ñëîÿìè, óäåðæèâàÿ êëàâèøó <Alt>. Êóðñîð ìûøè ïðè ýòîì 
èçìåíèòñÿ íà ñîîòâåòñòâóþùèé çíà÷îê (ðèñ. 2.11). 

 — êîððåêòèðîâî÷íûé 
ñëîé, êíîïêà äîñòóïíà 
íà ïàíåëè Layers.

Êîððåêòèðîâî÷íûé 
ñëîé èñïîëüçóåòñÿ 
äëÿ íàñòðîåê öâåòà 
îäíîãî èëè íåñêîëüêèõ 
ñëîåâ â èçîáðàæåíèè. 
Åãî îñîáåííîñòüþ 
ÿâëÿåòñÿ òî, ÷òî îí 
íå ìîäèôèöèðóåò 
ïîñòîÿííî ïèêñåëû è 
ïî æåëàíèþ ïàðàìåòðû 
öâåòà â ëþáîé ìîìåíò 
ìîæíî èçìåíèòü èëè 
âåðíóòü ê èñõîäíîìó 
âàðèàíòó.
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Ðèñ. 2.10. Îêíî èíñòðóìåíòà Hue/Saturation

Ðèñ. 2.11. Ãðóïïèðîâàíèå ñëîåâ ñ ïîìîùüþ êóðñîðà ìûøè

Ìàñêèðîâàíèå 
îáëàñòè

Íåäîñòàòî÷íî ïðîñòî íàëîæèòü ñëîè äðóã íà äðóãà, íåîáõîäèìî 
îáåñïå÷èòü ïëàâíîå ïåðåòåêàíèå èçîáðàæåíèÿ ñ îäíîãî ñëîÿ â 
äðóãîé. Òîëüêî â òàêîì ñëó÷àå ðåçóëüòàò áóäåò âûðàçèòåëüíûì 
è ýôôåêòíûì. Äëÿ ñîçäàíèÿ ïëàâíîãî ïåðåõîäà êàê íåëüçÿ 
ëó÷øå ïîäîéäåò ìàñêà, äîáàâëåííàÿ ê ñëîþ ñ èçîáðàæåíèåì 
äåðåâà (ðèñ. 2.12). 

http://www.htmlbook.ru


32www.htmlbook.ru — Èíôîðìàöèÿ îá HTML, CSS, ãðàôèêå è äèçàéíå   

Âëàä Ìåðæåâè÷. Ñîçäàíèå êîëëàæà â Adobe Photoshop

Ðèñ. 2.12. Ñòðóêòóðà ñëîåâ ïðè èñïîëüçîâàíèè ìàñêè

Ïåðâîíà÷àëüíî èçîáðàæåíèå âûãëÿäèò, êàê ïîêàçàíî íà 
ðèñ. 2.13. ×òîáû ñêðûòü ëèøíåå è ïîëó÷èòü ïîëóïðîçðà÷íûé 
ïåðåõîä, ëó÷øå èñïîëüçîâàòü ãðàäèåíòíóþ çàëèâêó îò ÷åðíîãî 
äî áåëîãî öâåòà. 

Ðèñ. 2.13. Ðåçóëüòàò äî ìàñêèðîâàíèÿ îáëàñòè

×åðíûé öâåò ñîîòâåòñòâóåò ìàñêèðîâàííîé îáëàñòè, áåëûé — 
îòîáðàæàåìîé, à îòòåíêè ñåðîãî îáåñïå÷èâàþò ïëàâíîñòü 
ìàñêè. Ìåñòà, êîòîðûå íåîáõîäèìî ñïðÿòàòü äîïîëíèòåëüíî, 
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ëó÷øå ìàñêèðîâàòü ïðè ïîìîùè êèñòè áîëüøîãî äèàìåòðà è 
ìÿãêèìè êðàÿìè. Öâåò êèñòè ñëåäóåò óñòàíîâèòü ÷åðíûì. 

Åñëè ðåçóëüòàò ïî êàêèì-ëèáî ïðè÷èíàì íå óñòðàèâàåò, 
ìîæíî ïåðåêëþ÷èòüñÿ íà áåëûé öâåò è âíîâü îòîáðàçèòü 
ìàñêèðîâàííóþ îáëàñòü.

Îêîí÷àòåëüíî, ðåçóëüòàò ìàíèïóëÿöèè ñî ñëîÿìè ïîêàçàí íà 
ðèñ. 2.14. 

Ðèñ. 2.14. Îêîí÷àòåëüíûé ðåçóëüòàò


	Вступление
	Подготовка изображений
	Коллаж 1. Девочка на грибе
	Использование быстрой маски
	1. Выделение объекта
	2. Переключение в режим быстрой маски
	3. Редактирование маски
	4. Возвращение в обычный режим редактирования
	5. Инвертирование выделения
	6. Изменение слоя Background
	7. Удаление фона
	8. Смягчение краев

	Использование слой-маски
	1. Изменение слоя Background
	2. Добавление слой-маски
	3. Редактирование слой-маски
	4. Удаление лишнего

	Наложение и трансформация слоев
	1. Наложение изображений
	2. Трансформация слоя

	Добавление тени
	Использование стиля слоя
	Создание тени с помощью слоев и фильтров


	Коллаж 2. Превращение
	Удаление фона
	Использование инструмента Magic Wand
	Использование инструмента Magic Erase

	Наложение и трансформация слоев
	Изменение цвета
	Маскирование области




